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SUMMARY 

An experimental study has been performed to examine the three-dimensional characteristics of 

laminar, transitional and turbulent flow over a elliptic cone lifting body configuration. The experimental 

studies were performed in the Calspan 48-inch shock tunnel and the LENS facility at Mach numbers 

between 8 and 12 and Reynolds numbers based on model length from 5 x 105 to 5 x 106. The model 

employed in these studies was a 4:1 elliptical cone configuration equipped with both sharp and blunted 

nosetip configurations. Detailed measurements of the distribution of heating and pressure were made along 

the leading edges and on the windward and leeward surfaces of the model with high frequency thin-film 

heat transfer gages and piezoelectric high-frequency pressure transducers. The model was densely 

instrumented with over 200 transducers, and measurements were also performed using temperature 

sensitive paints to further delineate the properties of the three-dimensional transitional flow. Flowfield 

measurements were obtained with a highly sensitive schlieren system to provide information on the 

character of the transitional flow field along the axis of the body. In preparation for studies inhigh enthalpy 

flows (10,000 and 15,000 ft/sec) flowfield calibration measurements were made in the LENS facility with 

intrusive pitot and total heating transducers and nonintrusive electron beam, and infrared radiometer 

techniques. These measurements obtained in these studies provide a unique database on the mean and 

fluctuating characteristics of the three-dimensional transition front of a lifting body at angle of attack in 

high Mach number flows. These data are of key importance to the validation of models of transitional flow 

used in the codes to describe the shape of the transition front and length and characteristics of the transition 

region on air-breathing hypersonic vehicles, such as those associated with the Hy-Tech and Hyper-X 

programs. These data have been incorporated into the CUBRC/AFOSR Hypersonic Database which has 

been modified to run on the Windows platform. 



1        Introduction 

One of the most difficult tasks in the design of hypersonic vehicles is to predict the position and 

characteristics of the three-dimensional transition region on lifting bodies at angles of attack. This 

information is even more important for the design of air breathing vehicles where the three-dimensional 

characteristics of the viscous flow entering the inlet plays a key role in engine performance. In the current 

predictive capabilities, such as the GASP code, which are currently available for vehicle design, the 

position of the transition front is basically an input to the code and the length and characteristics of the 

transition region are based on models derived from low speed flows over flat plates or cones at zero angle 

of attack. Measurements on flat plates and cones in supersonic and hypersonic flow have shown the 

transition region is highly unsteady, yet there are no models of transition to address this flow characteristic 

and there is a dearth of measurements which formulate and evaluate models of transitional flow. On a 

three-dimensional configuration such as elliptic cone at angle of attack flow, instabilities which lead to 

transition come from a number of sources. In addition, the usual first and second mode instabilities 

observed on simple cones at zero incidence transition on delta wing/elliptic cone configurations at 

incidences and are influenced by instabilities introduced by crossflow (Ref. 1) and leading edge 

contamination (Ref. 2). How these instability mechanisms interact to control the beginning of transition 

on three-dimensional lifting bodies is only now being explored However, there is almost no understanding 

of the mechanism which controls three-dimensional region of transitional flow, and in hypersonic flows, 

these regions will often cover on the order of one-third the vehicle length and therefore are of key 

importance. The problem of modeling these flows has generally taken second place to model transition; 

however, this situation must be addressed if we are to develop credible and accurate design procedure for 

vehicles other than the rocket propelled slender cones and blunt bodies. 

This program of experimental research and analysis was conducted to begin to assemble 

measurements which can be used to investigate the fundamental phenomena associated with laminar, 

transitional, and turbulent flow over lifting body configurations designed to operate at hypersonic flow 

conditions. An elliptic cone configuration was selected as a generic lifting body and the experimental 

program has been conducted to evaluate the characteristics of flow about this body for flow regimes where 

laminar, transitional and turbulent flows were generated over the model. In the experimental studies, which 

were conducted in the Calspan 48" tunnel and the LENS hypervelocity shock tunnel, detailed flowfield and 

surface heat transfer and pressure measurements were made with electron beam and high-frequency heat 



transfer and pressure instrumentation. Flowfield calibration studies were made to examine the freestream 

properties in the LENS facility employing high speed schlieren as well as pitot pressure, total temperature 

probes, and the electron beam Calculations were made to predict the properties of the freestream and 

provide information with which to select the model configuration and the position of the instrumentation 

on the elliptic cone. An extensive series of studies were conducted to examine the characteristics of three- 

dimensional transitional flows over the leading edge and windward and leeside surfaces of an elliptic cone 

at angles of attack from 0 to 5 degrees. The high frequency instrumentation employed in these studies 

allowed us to examine both the mean and fluctuating characteristics of the transitional flows over the 

model. Correlations of the position of the transition front and the length and characteristics of the transition 

region were obtained This information together with schlieren photographs of the flow are being included 

in the CUBRC/AFOSR hypersonic database which was upgraded during this study. This database contains 

measurements obtained in an extensive series of experimental studies of compact interacting hypersonic 

flows which were conducted over the past 35 years, many of which were supported by AFOSR. Recently 

we have modified the operating system for the database so that it can be run in Microsoft Windows or NT 

on an IBM compatible PC. The Windows-based system is far more user-friendly and now contains 

significantly more studies than the DOS version which was previously prepared and presented to AFOSR. 

A summary of the operation of the database is included in Section 4. 



2        Experimental Program 

2.1 Program Objectives and Design 

The principal objective of this experimental program was to obtain detailed flowfield and surface 

measurements over elliptic cone lifting bodies to define the laminar, transitional and turbulent structure of 

the flowfields over the windward and leeward sides of the vehicle. The experimental program was 

conducted over a large range of Reynolds numbers at Mach numbers of 8 and 11 to investigate the flow 

structure from laminar to turbulent flow conditions. Flowfield measurements were conducted at velocities 

from 8,000 ft/sec to 15,000 ft/sec in the LENS facility to evaluate the important real-gas effects on 

flowfield properties. The influence of boundary layer transition on the viscous flow structure and the 

distribution of surface properties on the windward and leeward side of the lifting elliptic cone body 

configuration was the subject of major investigation in this program. Detailed measurement of the heat 

transfer and pressure distribution over the model provided a database with which to evaluate the models 

and prediction techniques to described the three-dimensional transition characteristics of the windward and 

leeside flows on slender lifting bodies. 

The elliptic configuration selected for these studies was based on the examination of the models 

and measurements from earlier or current experimental studies, and computation employing state-of-the- 

art Navier-Stokes and DSMC codes. Examining the results from both the experimental and theoretical 

investigations, we examined both the models used in the numerical schemes, and the model configurations, 

test conditions, and instrumentation used in the experimental studies. As in all our earlier programs, the 

detailed design of the experimental program relied on an experimental database drawn from our experience 

and that generated in our other ground test programs. 

2.2 Experimental Facilities 

The experimental studies were conducted in Calspan's 48-inch and the LENS shock tunnel at 

Mach numbers ranging from 6.8 to 13, thereby spanning the regime 105 < Re < 6 x 106 which we believe 

from earlier studies is where the pressure rise occurs. The performance map for the 48-inch shock tunnel 

is shown in Figure 1. The operation of these tunnels can be shown simply with the aid of the wave diagram 

shown in Figure 2a. The tunnel is started by rupturing a double diaphragm, which permits the high- 
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pressure air in the driver section to expand into the driven section, and in so doing, generates a normal 

shock which propagates through the low pressure air. A region of high temperature, high pressure air is 

produced between this normal shock front and the gas interface between the driver and driven gas, often 

referred to as the contact surface. When the primary or incident shock strikes the end of the driven section, 

it is reflected, leaving a region of almost stationary high pressure heated air. This air is then expanded 

through a nozzle to the desired freestream conditions in the test section. 

The duration of the flow in the test section is controlled by the interactions among the reflected 

shock, the interface, and the leading expansion wave generated by the non-stationary expansion process 

occurring in the driven section. At Calspan, the initial conditions of the gases in the driver and driven 

sections are normally controlled so that the gas interface becomes transparent to the reflect shown as 

shown in Figure 2a; thus, there are no waves generated by the interface-reflected shock interaction. This 

is known as operating under "tailored-interface" conditions. Under this condition, the test time is controlled 

by the time taken for the driver/driven interface to reach the throat, or the leading expansion wave to 

deplete the reservoir of pressure behind the reflected shock; the flow duration is said to be either driver gas 

limited or expansion limited, respectively. Figure 2b shows the flow duration in the test section as a 

function of the Mach number of the incident shock. Here it can be seen that for operation at low MjS, 

running times of over 25 milliseconds can be obtained with a long driver section. When run under these 

latter conditions at high pressures and Reynolds numbers, the test running times are of the same magnitude 

or longer than for piston driven tunnels (Refs. 3, 4) with comparable stagnation temperatures, and the 

reservoir conditions and flow quality are superior to piston driven tunnels. This results from the fact that 

test gas has been processed by a simple reflected shock rather than multiple shocks as in piston tunnels. 

A further consequence is that the freestream conditions can be calculated with far more accuracy in a shock 

tunnel. 

LENS is a chambered shock tunnel having a 24-ft-long driver tube with an internal diameter of 

12 inches and a driven tube 8 inches in diameter, which is 60 ft long. The basic layout of the LENS facility 

is shown in Figure 3. To achieve velocities of up to 5 km/sec, the driver section of the tunnel (shown in 

Figure 3) is heated to 750°F and is fitted with a stainless steel liner for hydrogen operation. The tunnel can 

be operated at pressures up to 30,000 psi, and, to achieve a 2 to 3 run/per-day rate, a new high-pressure, 

high-flow-rate compressor was installed to provide a pumping capacity that will fill the driver in 

approximately one hour. The driver and heater section of the tunnel are mounted on carriages that recoil 

with the tunnel as it is fired. A double diaphragm rig is used to accurately control the test conditions. In 



this device, two diaphragms are separated by an intermediate chamber, which is held at approximately half 

the driver pressure; the pressure in the intermediate chamber is rapidly increased to fire the tunnel. 

Diaphragms over 18 inches in diameter and 1.25 inches thick are employed that are machine-scored to 

obtain controlled bursts with a minimum amount of fragmentation, which required a significant 

development program. To enable accurate studies of flowfield chemistry, cleanliness is of prime importance 

in the design and operation of the facility. All components that come into contact with the test gas are 

constructed from stainless steel, or as in the reservoir region, are constructed from copper or copper alloys. 

To eliminate gaps between driven-tube components resulting from the 2- to 4-million-pound recoil loads, 

each of the stainless steel tubes is fastened together with high-strength tensile bolts, which are pre-stressed 

to prevent tube separation. A centerbody apparatus, which employs a fast-acting plug valve to close the 

nozzle throat, is used to terminate the flow once the uncontaminated volume of shock-heated air has been 

exhausted from the reservoir region of the shock tube. The reservoir and centerbody region of the shock 

tunnel are lined with copper in order to prevent burning. Copper, molybdenum, or tungsten is used for the 

throat section of the tunnel to prevent melting and burning. The centerbody is a key feature for a facility 

designed to test fragile and expensive aero-optic components, because it prevents particulates from the 

diaphragm from impinging on the seekerhead window. Because the high heating rates generated in the 

nozzle are concentrated in a relatively small region close to the throat, the major portion of the contoured 

nozzle can be constructed from fiberglass. To handle the large loads generated by the recoil of the tunnel, 

a metal corset, which surrounds the fiberglass nozzle, is used to couple the driven tube with the test sectioa 

Shown in Figure 4 is the Mach 11 to 18 contoured fiberglass nozzle, which has an exit-plane diameter of 

48 inches. Mach 8 is also available. The test section, shown in Figure 4, has an internal diameter of 96 

inches and has been constructed so that it can be coupled with nozzles with exit planes up to 72 inches in 

diameter. 

2.3       Models and Instrumentation 

An elliptic cone configuration was selected for this study as typical of a hypersonic lifting body 

configuration after an extensive review on the database of measurements on such a configuration in non- 

continuum and continuum flows. The specific elliptic cone configuration was chosen to be compatible with 

the configurations which have been or are being employed in different but complementary studies in several 

other laboratories. A drawing of the elliptic cone model illustrating its shape and dimensions is given in 

Figure 5a. Two nosetip configurations have been constructed for this model: the sharp configuration which 

results in a model whose total length is 21 inches and a blunted configuration resulting in a model length 



of 19-3/4 inches. The model is shown installed on the low-load sector in the 48" shock tunnel equipped 

with the D-nozzle in Figure 5b. In the contoured D-nozzle, measurements will be made in continuum and 

non-continuum flows over a range from 11 to 18. Later we will obtain measurements in the Mach number 

range from 6 to 8 in the contoured A-nozzle. 

The elliptic cone model is highly instrumented with 212 high-frequency, thin-film and piezoelectric 

pressure transducers. The thin-film instrumentationhas been positioned along and around the swept leading 

edges of the elliptical body as well as in the flatter surfaces on the windward and leeward sides of the model 

as shown in Figures 6 and 7. The position of the instrumentation was designed to provide highly spatially 

resolved measurements of the boundary layer transition process along and perpendicular to the leading edge 

of the vehicle in order to describe the detailed characteristics of flows associated with attachment line and 

cross-flow transition. The instrumentation placed on the flatter surfaces was designed to provide a detailed 

mapping of the transition front associated with cross-flow transition and also the characteristics of the 

separated region on the leeside of the elliptic cone held at angle of attack. A photograph of the model is 

shown in Figure 8. A major objective of the current studies is to define the large-scale, high-frequency 

movement of the transition front on the face of the model as well as the characteristics of turbulence 

through the transition process. In almost all of the earlier studies, the instrumentation that was employed 

did not provide information on the unsteady nature of the process or the fluctuations in the heat-transfer 

rate along the transition region. We also wish to provide measurements to further define the unsteady 

movement of two- and three-dimensional disturbances which proceed the transition process similar to that 

obtained on conical bodies in our earlier studies (see Ref. 5). 

2.3.1    Surface Instrumentation 

Heat Transfer Instrumentation - The miniature heat transfer instrumentation that was used is 

based on the thin-film heat transfer technique, in which a thin-film platinum resistance thermometer on a 

Pyrex substrate is used to sense the surface temperature of a low-conductivity surface. The transient 

response of this instrumentation is such that it is ideally suited to the detection of turbulent bursts and the 

unsteady nature of the transition region. As the heat capacity of the thin film is negligible, the film 

temperature is a measure of the instantaneous surface temperature of the Pyrex and is related to the heat 

transfer rate by the classical equation of heat transfer into a semi-infinite slab of known thermal 

characteristics. Analysis has shown this technique to be valid for 0.1 micron thick gages during the short 



duration of a shock tunnel test. Final data reduction uses the Ray-Taulbee algorithm to relate the 

temperature time history to the transient heat transfer rate. 

Pressure Instrumentation - The pressure transducers that would be used in this program are 

piezoelectric types of a design developed by Calspan and manufactured by PCB Piezotronics, Inc. (Models 

103A and 103M14). These sensors have high sensitivity, and linearity generally better than 2 percent, over 

an operating range of about four orders of magnitude. If the linearity is not within 2 percent, a log-log 

curve fit is made to the calibration data, and this results in all data being within 2 percent of the curve. The 

Model 103A transducers have a maximum pressure capability of 3 psi. The Model 103M14 transducers 

have a maximum capability of 100 psi. The transducers are internally compensated for acceleration to 

nominal level of 0.001 psi/g. 

2.3.2    Flowfield Instrumentation 

Intrusive Instrumentation - Three sets of instrumentation have been used to probe the flowfield 

under low-enthalpy conditions. These are mean-frequency pitot probes, total-temperature probes, and thin- 

film probes. The Kulite-based high-frequency pitot probes have a frequency response of 30 kHz. The total 

temperature gages and the thin-film gages gave us the ability to measure fluctuations of up to 1 kHz and 

500 kHz, respectively. Both the pitot-pressure and thin-film instruments could be used to obtain turbulent 

scale size in the mixing region of the flowfield. 

Non-intrusive Instrumentation - Electron Beam Technique. Measurements were made using an 

electron-beam apparatus developed for a complementary research program (Ref. 6 and 7). Figure 9 shows 

the basic model configuration with the electron beam optics installed and surveying the freestream flow. 

The density and temperature measurement instrumentation is based on the observed relationship between 

the fluorescent intensity of the band system and the molecular number density. This relationship is obtained 

by calibration, using the same optical arrangement, over a comparable range of gas number densities and 

temperatures. Rotational and vibrational temperatures were determined by measuring the relative intensities 

of the rotational lines and vibrational bands of the emitted light. To do the former with any degree of 

precision, a high-dispersion spectrograph was used, which replaced the filter and photomultiplier. 

Vibrational temperatures are measured by splitting the light from the observed part of the beam between 

two or more photomultipliers, each with appropriate narrowband filters that select different vibrational 

bands in the spectrum. 
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3        Results and Discussion 

3.1       Studies of Laminar, Transitional and Turbulent flows 
Over an Elliptic Cone Lifting Body 

3.1.1    Introduction 

This phase of the experimental study was directed toward investigating the aerothermal 

characteristics of the transitional flow over a 4:1 elliptical cone model at angles of attack, for freestream 

conditions to obtain laminar, transitional and turbulent boundary layers over the cone surface. The basic 

objective of the investigation was to provide information with which to model the shape of the transition 

front and the length and properties of the transitional flow over three-dimensional lifting bodies at angles 

of attack. The large uncertainties in the prediction of these regions on vehicles such as those being 

considered for the Air Force Hy-Tech program and the NASA Hyper-X program make it of key importance 

to validate the theoretical prediction methods with measurements of the type obtained in this program The 

experimental program was conducted in the Calspan 48" shock tunnel at Mach numbers between 8 and 

12 at angles of attack from 0 degrees to 5 degrees. A key aspect to this program was the utilization of 

closely spaced thin-film instrumentation with the capacity to follow the turbulent fluctuations associated 

with the transition of the boundary layer along the leading edge and in regions of cross flow around the 

leading edge. High velocities that occur in hypersonic flows result in the requirement to follow frequencies 

above 10 kHz to accurately define the transient characteristics of the boundary layer as it transitions from 

laminar to turbulent flow. The thin film heat transfer instrumentation employed in this study is capable of 

following frequencies well above this requirement. We have also employed high-frequency pressure 

instrumentation capable of resolving fluctuations up to 30 kHz. 

3.1.2    Discussion of Surface and Flowfield Measurements 

In this experimental program, measurements were made with the elliptic cone configured with both 

sharp and blunted nosetips for a series of Reynolds numbers at Mach numbers of 8 and 11 to examine the 

effects of these parameters on the position of transition and the characteristics of the transition region. 

Each of these studies were repeated for angles of attack of 2.5 and 5° where measurements were made both 

on the windward and leeside surfaces of the model. The instrumentation package employed in this 

investigation is shown in Figures 7, 10 and 11 where we show the location of instrumentation on the 

leading edge and elliptic surface of the model. The instrumentation was situated along conical rays 

originating from the leading edge and the data which is plotted in the following graphs is from the six rays 

illustrated in Figure 11. 



In the following paragraph, we briefly review some of the basic results from the experimental 

studies. A detailed analysis and correlation of these measurements will be published at an upcoming 

conference on transition. In Figures 12a and 12b, we show the variation in the distribution of heating rate 

to the elliptic cone surface with Reynolds number. While it can be seen that while at the lowest Reynolds 

number, transition on the centerline begins to occur at 8 inches back from the nosetip, increasing the 

Reynolds number results in the forward movement of the transition front with the centerline becoming fully 

turbulent along the instrumented length of the elliptic cone. Further measurements at a slightly higher 

Reynolds number, lower Mach number condition are shown in Figures 13a and 13b. Here we were able 

to obtain a fully turbulent boundary layer over almost all of the instrumented surface at the highest 

Reynolds number condition with transition occurring very close to the leading edge of the cone. 

Placing the model at an angle of attack of 2.5 degrees, the heat transfer measurements obtained 

on the windward and leeside surfaces of the elliptic cone, shown in Figures 14a and 14b, respectively, 

demonstrate that angle of attack tends to delay transition on the leeside, and move the position for transition 

forward on the windward side of the model. This behavior is in contrast to measurements obtained at 

similar flow conditions over sharp cones (Ref. 5) where we observe transition to move forward on the 

leeside as angle of attack increases. Similar trends can be observed from the measurements obtained at 

higher Reynolds numbers shown in Figures 15a and 15b and at the lower Mach number, high Reynolds 

number condition in Figures 16a and 16b. We again observe that unlike the axisymmetric cone data, angle 

of attack at the highest Reynolds number transition moves forward on the windward side and rearward on 

the leeside as show in Figures 17a and 17b. 

The measurements obtained at an angle of attack of 5 degrees are shown in Figures 18 through 

21 provide information which again indicates that the transition front moves rearward with increasing angle 

of attack In the case of the measurements shown in Figures 18a and 18b, we see that at 5 degrees 

incidence the leeside of the model remains the most fully laminar while there is turbulent flow along the 

axis of the windward surface and transitional flow across the remainder of the surface. Under the higher 

Reynolds number conditions shown in Figures 19a and 19b, we were able to obtain transition along the 

leeside line along the elliptic cone while again the windward plane exhibits a turbulent flow characteristics 

along most of the lower surface. Similar trends are observed in Figures 20 and 21. 

The effect of bluntness illustrated in measurements shown in Figures 22a and 22b is to move the 

transition front rearward on both the windward and leeside surfaces of the model. The length of the 

transition region also appears to be lengthened as a result of surface bluntness. 

10 



In another series of studies, we examined the effect of yaw angle on the heat transfer rates along 

the leading edge of the elliptic cone. Measurements at yaw angles of 5 and 10 degrees shown in Figures 

23 and 24 illustrate that in contrast to the measurements in the absence of yaw illustrated in Figure 25 

transition begins to occur at approximately 18 inches from the tip of the model. The occurrence of leading 

edge transition at the greater sweep angle was consistent with predictions based on correlations obtained 

from earlier studies of leading edge transition (Ref. 2). Figures 26-29 are schlieren photographs of 

transitional flow over the elliptic cone. 

Measurements obtained in these studies are presently being compared with laminar and turbulent 

flow predictions employing the GASP code and correlations of the position and transition and the 

characteristics of the transition region are being assembled to aid in the selection of models to be employed 

to calculate the streamwise variation of heat transfer rate in the transition region. 

11 



3.2       Calibration of Hypervelocity Flowfields Employing Intrusive Instrumentation 
and Electron Beam Techniques 

3.2.1 Introduction 

During this program, we have employed an electron beam apparatus to obtain density and species 

measurements to define thecharacteristics of the nonequilibrium hypersonic flows, encountered under some 

of our high enthalpy conditions. The electron beam apparatus has in the past been used extensively to 

obtain measurements in low-density flows in these studies we have employed an electron-beam gun which 

enables measurements to be obtained under higher pressure conditions where transitional and turbulent 

flows can exist. This set of measurements were designed to not only provide flowfield calibration data but 

also yield a set of measurements which can be used to validate the models of flowfield density employed 

in our nonequilibrium nozzle code. The electron beam instrumentation is capable of following the high 

frequency density fluctuations which occur in the boundary layer during the transition process as 

demonstrated in Reference 7. 

3.2.2 Flowfield Measurements 

The electron beam apparatus was installed in a specially designed survey model to obtain 

measurements of the freestream characteristics of hypervelocity flows. The model which contained the 

electron beam is shown installed in the LENS facility in Figure 30. A schematic diagram of the electron 

beam installed in the survey model positioned to survey the flow in the LENS facility is shown in Figure 9. 

This apparatus was used in a series of studies to define the nonequilibrium composition of the flow at 

velocities of 10,000 and 15,000 ft/sec where vibrational and chemical nonequilibrium occurred. Typical 

measurements of the nitrogen spectrum which are employed to provide information on the vibrational and 

rotational temperature of the gas are shown in Figure 31. Similar data are also shown of NO radiation in 

Figure 32 from measurements to define the magnitude of this constituent of the flow. Measurements of the 

mean freestream density and temperatures made with the electron beam were found to be in good agreement 

with nozzle flow calculations. Figure 33 a and b shows a comparison between the time histories of pitot 

pressure and C02 radiation signal obtained at 14,200 ft/sec illustrating that both the aerodynamic and 

aerothermodynamic properties of the flow provide comparable useful test times of close to 6 milliseconds 

at this condition. 

In an additional electron beam study, an extensive series of calibrations and measurements were 

made in an attempt to use this apparatus to determine the end of the run by detecting the occurrence of 
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helium or a trace gas in the flow which originated in the driver section of the tunnel. Helium is used as a 

driver gas for a number of high-temperature conditions; while a trace gas can be added to either the double 

diaphragm set and the tunnel or the driver. We wished to excite this gas by the electron beam and thereby 

provide definitive measurements of when the driver gas is present in the test flow. A number of additives 

such as argon and xenon were tested as to their effectiveness as a tracer; however, although we were able 

to employ the electron beam to excite these gas in a static calibration rig after an extensive series of tests, 

we were unsuccessful in using such an approach to positively define the end of the useful test time of the 

flow. 
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4        Assembly and Refinements of the CUBRC/AFOSR Hypersonic Database 

4.1       Introduction 

One of the most important outputs of an experimental program, in addition to the improved 

understanding of the phenomenology, is the assembly of measurements which can be used to develop and 

refine models of the key phenomena controlling the characteristics of the flow. With the development of 

DSMC and Navier-Stokes codes capable of accurately defining the characteristics of laminar flow of a 

perfect gas, the emphasis has now swung to understanding and modeling real gas phenomena in laminar 

flows and transitional and turbulent mixing phenomena for flows at Reynolds numbers larger than those 

required to maintain fully laminar flow. From the viewpoint of the design of hypervelocity vehicles, the 

most critical design areas are associated with the high aerothermal loads which occur in regions of shock 

wave/boundary layer and shock/shock interaction, and the efficiency of active cooling techniques which 

are in many cases required to alleviate the aerothermal loads in such regions. The experimental studies 

conducted for AFOSR during the past 35 years have been highly oriented toward the investigation of such 

phenomena, and from these studies, we have selected the most useful and accurate sets of measurements 

to be included in the CUBRC database. The measurements placed in the database fall into four basic areas: 

(1) measurements made in laminar flows on simple flow configurations as well as in regions of shock wave 

boundary layer interaction and shock/shock interaction; (2) measurements in transitional flows over simple 

model configurations as well as on configurations involving adverse and favorable pressure gradients and 

cross flows; (3) measurements made in turbulent flows over simple configurations as well as those in 

regions of shock/shock and shock boundary layer interaction; and (4) measurements of the performance 

and effectiveness of active cooling techniques such as film and transpiration cooling with and in the 

absence of regions of shock/shock and shock boundary layer interaction. All of the measurements provided 

in this database were for well-defined model and flowfield configurations with instrumentation capable 

of high resolved temporal and spatial resolution. 

As discussed earlier, we have recently upgraded the system which controls the database so that 

it can be operated in a Windows 95 environment with the result that it is more easily operated by users 

familiar to the PC Windows environment. This recent upgrade is described in Appendix 1. 
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4.2       Review of CUBDAT Database Program 

4.2.1 Overview 

CUBDAT is a program designed to provide access to reduced data from experimental studies 

conducted in Calspan's shock tunnels from 1964 to the present. Available to qualified users, CUBDAT 

can only be run on PC's running Microsoft® Windows® 95 or NT, there are no plans to develop versions 

for other platforms. Interaction with CUBDAT is consistent with the standard Windows interface, 

although its overall design is based on the previous, DOS version (see "A Database of Aerothermal 

Measurements in Hypersonic Flow for CFD Validation" AIAA 92-4023). 

Data for CUBDAT is stored in binary files with the extension .STY. These study files contain 

data from a number of runs as well as test conditions and summary information. Each study requires that 

a separate text file containing the abstract present in the same directory. Individual runs can be exported 

in a delimited text format compatible with most spreadsheet programs. 

Runs are divided into sixteen groups, representing different sensor positions or conditions. While 

every run is divided in this manner, not all groups contain data; often only the one or two groups will 

contain data. Runs may also include a time index, indicating the time (in milliseconds) from the start of 

the run that the data represents. 

4.2.2 Viewing Data 

To open a study for analysis, select "Open study" from the File menu, select the file you wish to 

open, and click the "Open" button. To view the data or test conditions for a run, the user must first select 

a default run. To do this, choose "Select run f from the Data menu and choose a run from the list provided. 

Selecting "View test conditions" will display the test conditions for the default run. Selecting "View run 

data" will display all of the data associated with the default run. To copy text to the Windows Cupboard, 

choose "Copy to cupboard" from the Data menu. 

Once a default run has been selected, it can be exported as delimited text, a generic format that 

can be read by most spreadsheet programs. To do this, select "Export run as text" from the "File" menu. 

The data will be saved with tabs separating columns and carriage returns separating rows. 
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4.2.3    Plotting Data 

Once a study has been open, different data from various runs may be plotted for analysis. Plots 

are set up by selecting "Define variables" from the Plot menu. This will bring up the variable definition 

window. Up to sixteen different data sets (referred to here as variables) may be plotted simultaneously. 

The instructions that follow define a single variable, to plot multiple variables, select a different variable 

from the list at the top of the window and repeat the procedure. 

To include a variable in the plot, check the "Variable Active" box. The "Plot Style" box controls 

the appearance of the variable. To change the color, double-click in the "Color" box. If "Line" is checked, 

lines will be drawn between data points. If "Symbol" is checked, the symbol indicated in the symbol list 

will be plotted at each point. 

The "Run Number" list selects the run from which the variable will draw its data. The "Data 

Type" list selects the type of data (pressure, heat transfer rate, etc.) for the variable. The "Normalizing 

Factor" list selects the factor used to non-dimensionalize the data; factors can be selected from the list or 

a numerical value may be entered. The "Active Groups" box determines which groups (of the selected run) 

will be included in the variable. Use the "Activate All" and "Deactivate All" buttons to quickly enable or 

disable all groups. Finally, the "Name" box contains the legend entry for the variable. 

Once all variables have been defined, click the "OK" button to view the plot. 

To change the domain and range of the plot, select "Adjust range" from the Plot menu. "Set 

symbol size" allows the user to change the size of the symbols used in the plot (default is 3 pixels). "Set 

axis titles" allows the user to change the names of the axes. "Set plot font" allows the user to change the 

font used in the plot (default is Times New Roman, 14pt). 

To fit a polynomial to a variable, select "Fit" from the "Polynomial fit" sub-menu. The variable 

to which the curve will be fitted is selected from the list at the top of the Polynomial fit window. Enter the 

degree of the curve in the "Degree of fit" box. The color of the fit curve is set with the "Color" box 

(double-click to change).  If the "Draw fit" box is checked, the curve will be drawn on the plot. If the 
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"Legend entry" box is checked, the equation of the curve will be included in the legend. The equation of 

the curve can also be found by selecting "View coefficients" from the "Polynomial fit" sub-menu. 

To copy a plot to the Windows clipboard, select "Copy to clipboard" from the Data menu. The 

plot will be copied as a scalable Windows metafile. Due to inconsistencies in the treatment of metafiles 

between programs, plots may not copy exactly. On some programs, sideways text may appear as 

horizontal on the screen, however it should appear properly when printed. 

4.2.4 .STY File Format 

This section is provided for those who wish to access CUBDAT data directly. Information given 

in this section is based on the C/C++ language. 

4.2.5 Data Types 

Type Size(bytes) Range 

char 1 -128 to 127 

unsigned char 1 0 to 255 

short int 2 -32,768 to 32,767 

int 4 -2,147,483,648 to 

2,147,483,647 

float 4 -3.4 x 10+38 to 3.4 x 10+38 

A number within braces ([]) indicates an array. For example, int Array[10] indicates an array of 10 four- 

byte integers, with indices from 0 to 9, inclusive. 

4.2.6    Data Structures 

The following data structures are the same as those used within CUBDAT to store data. Placing 

structures within structures may cause confusion, but it provides a convenient way to organize the data. 

The _RuiüT> structure identifies each run in a study by number and time index. A value of -1 for 

Time indicates that there is no time index associated with the run. 
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struct _RunID 

{ 

short int Number; 

float Time; 

}; 

The _StudyInfo structure contains the summary, abstract filename, group labels, and a list of the run 

numbers that appear in the file. 

struct _StudyInfo 

{ 

char Name[64]; 

char Summarylnfo[1024]; 

char AbstractFilename[256] 

char GroupLabel[16][32]; 

char AxisLabel[64]; 

unsigned char NumRuns; 

_RunID RunList[256]; 

}; 

//the name of the study 

//summary text 

//the file name of the abstract 

//sixteen group labels 

//the default label for the x-axis 

//number of runs 

//included run numbers 

The _DataPoint structure holds the group number, position, and value of a single data point. 

struct _DataPoint 

{ 

unsigned char GroupNumber; 

float Position; 

float Value; 

}; 

//acceptable values from 0 to 15 

The _DataSet structure is essentially an array of _DataPoints. 

struct _DataSet 

{ 

unsigned char NumData; //number of data points 

_DataPoint Data[256];  //array of data points 

}; 
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The _Run structure contains test conditions and one _DataSet for each type of data (pressure, skin friction, 

etc.) 

struct JRun 

{ 

_RunID ID; 

float Po; 

float Ho; 

float To; 

float Hw; 

float Tw; 

float Mi; 

float M; 

float U; 

float T; 

float P; 

float Rho; 

float Mu; 

float Re; 

float Pop; 

float Q; 

float CPf ; 

float CHf; 

float QoFR; 

//this run's identification 

//reservoir total pressure 

//reservoir total enthalpy 

//reservoir total temperature 

//wall enthalpy 

//Wall temperature 

//shock tube incident mach number 

//freestream mach number 

//freestream velocity 

//freestream temperature 

//freestream static pressure 

//freestream density 

//freestream viscosity 

//freestream Reynolds number 

//Pitot pressure (Po') 

//dynamic pressure 

//pressure to CP factor 

//heat rate to CH factor 

//Fay-Riddell heat transfer 

char ExtraTC[16] [64] ;  //16   additional 

//character strings) 

test conditions (64- 

_DataSet DataSet[7]; //see below 

}; 

DataSetfO] = pressure data 

DataSetfl] = skin friction 

DataSet[2] = force/moment 

DataSet[3] = heat transfer rate 

DataSet[4] = surface temperature 
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DataSet[5] = calorimeter 

DataSet[6] = miscellaneous 

4.2.7    File Format 

The first item in any .STY file is a _StudyInf o structure. There then follows one _Run 

structure for each run listed in _S tudylnf o. RunLi s t. _Run structures appear in the same order as 

their entries in _Studylnf o. RunList 
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Figure 20a       TYPICAL HEAT TRANSFER RATE IN TRANSITION 
REGION ON WINDWARD SURFACE OF ELLIPTIC 
CONE AT 5° INCIDENCE AT MEDIUM REYNOLDS 
NUMBER AT MACH 11 
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TYPICAL HEAT TRANSFER ON WINDWARD RAY OF 
ELLIPTIC CONE AT 5° INCIDENCE AT HIGH 
REYNOLDS NUMBER AT MACH 8 
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Figure 21b       TYPICAL HEAT TRANSFER ON LEESIDE RAY OF 
ELLIPTIC CONE AT 5° INCIDENCE AT HIGH 
REYNOLDS NUMBER AT MACH 8 
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Figure 22a       TYPICAL HEAT TRANSFER MEASUREMENTS 
ON ELLIPTIC CONE YAWED AT +10° AT 
MEDIUM REYNOLDS NUMBER AT MACH 8 
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LENS Run 323-L3-54 
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5!      § 
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Figure 31 N2 SPECTRA FROM ELECTRON BEAM STUDIES 
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Uns run 56 

Figure 32 NO SPECTRA FROM ELECTRON BEAM APPARATUS 
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Figure 33a C02 RADIATION SIGNAL TIME HISTORY 

Pressure Time History 

Figure 33b PITOT PRESSURE MEASUREMENT TIME 
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